
Printer Specifications
The printer provides the following features:

Two print cartridges that provide color and true black printing without having to 
switch print cartridges.

On-screen or verbal feedback of printer status.
Low cost, near laser-quality print.
Print Quality Enhancement Technology (PQET) that digitally enhances text and lines 

to produce smoother curves and sharper edges.
Quiet operation.
Printing support for Windows-based DOS applications.
Portrait and landscape orientation.
Indicates when the print cartridge is low on ink.
Superior paper handling in the industry for this class of printer.
Supports index cards, labels, envelopes, transparencies, and plain, coated and glossy

paper.
Supports automatic envelope feeding.
Has 9-inch (23-cm) wide manual feed slot.
Compatible with:
Microsoft Windows 3.1 or higher.
Windows for Workgroups.

Printer dimensions
Height 297 mm 11.7 in.
Width 436 mm 17.2 in.
Depth 269 mm 10.6 in. 
Weight 4.3 kg 9.5 lbs.
Temperature and humidity
Print quality can vary depending on air temperature and relative humidity. 
Operating temperature range: 10° to 40°C (50° to 104°F)
Optimum print temperature range: 16° to 32°C (60° to 90°F)
Optimum humidity range 20% to 60% RH
Operating humidity range: 8% to 80% RH (non-condensing)
See also
Your printer User's Guide



 Paper, Envelope, Transparency, and Label Specifications
Paper Types and Sizes
Envelope Types and Sizes
Transparency Types and Sizes
Label Types and Sizes



Paper Types and Sizes
Satisfactory print quality can be obtained with many types of plain paper. Since the quality 
of plain paper varies widely, you should test the print quality before buying large quantities
of paper.
To print on card stock, load the card stock with the envelope guides turned in, just as you 
would load an envelope.
The printer uses a variety of papers including:

Xerographic paper
Bond paper
Dual-purpose paper
Recycled bond paper

Because all paper varies in physical characteristics, you can receive mixed results from 
different packages of paper even though the packages contain the same type of paper. If 
you encounter undesirable results, try the other side of the paper, a different type, or 
another package of the same kind of paper.
Do not use the following types of paper with the printer:

Continuous form feed paper
Erasable bond paper
Synthetic paper
Thermal paper
Multi-sheet forms and documents
Chemically treated paper (carbonless paper)
Papers printed with a printing process that uses chemicals that contaminate the 

paper feed mechanism components (paper with raised, embossed lettering)
Most papers have a preferred print side that is indicated on the paper package. Load the 
paper so the preferred print side faces you.
The following paper sizes can be used in the sheet feeder and the manual feeder:

Paper size mm inches
Letter 216 x 279 8.5 x 11.0
Legal 216 x 356 8.5 x 14.0
B5 182 x 257 7.2 x 10.1
A4 210 x 297 8.3 x 11.7
Executive 184 x 267 7.3 x 10.5
A5 148 x 210 5.8 x 8.3
Index card 76 x 127 3.0 x 5.0 
Postcard 102 x 152 4.0 x 6.0
    Note: Card stock must be loaded as envelopes.
Use paper that meets these specifications in the Sheet Feeder:

Length 127 to 364 mm 5.0 to 14.33 in.
Width 89 to 216 mm 3.5 to 8.5 in.
Weight 60 to 90 g/sqm 16 to 24 lb
Thickness 0.071 to 0.18 

mm
0.0028 to 0.007 
in.

Use paper that meets these specifications in the Manual Feeder:
Length 127 to 364 mm 5.0 to 14.33 in.
Width 76 to 228 mm 3.0 to 9.0 in.
Weight 60 to 120 g/sqm 16 to 32 lbs.
Thickness 0.071 to 0.18 

mm
0.0028 to 0.007 
in.



See also
Your printer User's Guide



Envelope Types and Sizes
The following envelopes can be used in the sheet feeder:

Envelope size mm inches
# 7-3/4 98 x 191 3.9 x 7.5
# 9 98 x 225 3.9 x 8.9
# 10 (U.S. 
Business)

105 x 
241

4.1 x 9.5

DL 110 x 
220

4.3 x 8.7

C5 162 x 
229

6.4 x 9.0

B5 176 x 
250

6.9 x 9.8

postcard 102 x 
152

4.0 x 6.0

index card 76.2 x 
127

3.0 x 5.0 

C6 114 x 
162 

4.5 x 6.3

Note: To print on card stock, load the card stock with the envelope guides turned in, just as 
you would load an envelope.
The dimensions for the manual feeder are:

Length 127 to 364 mm 5.0 to 14.33 in.
Width 76 to 228 mm 3.0 to 9.0 in.
Weight 60 to 120 

g/sqm
16 to 32 lbs.

Do not use the following types of envelopes:
Envelopes with windows, holes, perforations, cutouts, or deep embossing
Envelopes with a metal clasp, a string tie, or metal folding bars
Envelopes with peel-off sealing strips
Envelopes with contents enclosed 

The printed image is not waterfast. You may want to place a piece of transparent tape over 
the print when you print on envelopes.
See also
Your printer User's Guide



Transparency Types and Sizes
The printer supports letter and A4 size transparencies. Use a transparency designed for an 
ink-jet printer. Do not use transparencies designed for copiers and laser printers, or for pen 
plotters. 
When handling transparencies:

Do not touch the side of the transparency to be printed on.
Store unused transparencies in the original packaging.
Do not store transparencies in excessively hot or humid environments.

Transparencies take time to dry. Be careful not to touch the printed surface until the ink is 
dry. 
If you are printing several transparencies at one time, remove each transparency as it exits
the printer and allow it to dry before stacking. 
Use the sheet feeder to print on transparencies. The page sizes for transparencies are:    

Paper size mm inches
Letter 216 x 279 8.5 x 11.0
A4 210 x 297 8.3 x 11.7

See also
Your printer User's Guide



Label Types and Sizes
Use the sheet feeder or manual feeder to print on labels. The page sizes for labels are:

Label size mm inches
Letter 216 x 279 8.5 x 11
A4 210 x 297 8.3 x 11.7
For best results, labels used in the printer should meet the following requirements:

Do not use label sheets with a slick backing material.
Be sure the adhesive does not come in contact with any part of the printer.
Use full label sheets. Partially used sheets (with areas exposed by missing labels) can

cause labels to peel off during printing and can damage the printer.
If the sheet feeder will not feed your labels, try the manual feeder.
See also
Your printer User's Guide



Using Help in the Printer Driver

Using Help 
Click on Search. 

Enter a term in the Search dialog box.    
Click on Show Topics for a list of related topics.

Click on Back to return to the topic you just viewed; or Click on History and select a 
topic from the list.

Click on Contents to go back to the main table of contents for this help file.
Click hot text or a hot graphic for more information.

The mouse pointer changes from an arrow to a pointing hand when it is over hot text or 
graphics. 

Getting Help on a Tab, Dialog Box, or Message
Click on Help in the tab, dialog box, or message.
Click an option in the tab or dialog box and press F1.

Getting More Information on Using Help in Windows
Press F1 when online Help is displayed.
Click How To Use Help from the Help menu when online Help is displayed.



OKIDATA Support and Service
 This information is valid for the United States and Canada only. 

When you call, you should be at your computer and have your OKIJET(tm) 2010 User's 
Guide at hand. Be prepared to give the following information:

Serial no. of your printer (located on back panel)
Type of computer hardware you are using
Exact wording of the messages that appeared on your screen
What happened and what you were trying to do when the problem occurred
How you tried to solve the problem

Contact Your Dealer
Consult the store where you purchased your printer, or call 1-800-OKIDATA for the location 
of the nearest Authorized OKIDATA Service Dealer. Have your ZIP code ready.
Use The OKIDATA Information System Automated Attendant
Call 1-800-OKIDATA. The OKIDATA Information System Automated Attendant is available 24 
hours a day, 7 days a week. 
Use OKIDATA Faxable Facts
Call 1-800-654-6651 and have your choice of product support bulletins, the latest 
information on print cartridges, etc., automatically faxed to you directly.
Contact Your OKIDATA Customer Support Representatives
Call 1-800-OKIDATA to speak with an OKIDATA Customer Support Representative, Monday 
through Friday, 8 a.m. to 6 p.m. EST.



OKIDATA Regional Service Depots
Call the nearest depot for a return authorization number
Allow 3½ business days for repair via a depot
Carry-in repairs must be called in first to schedule service

East: 57 Carnegie Plaza
Cherry Hill, NJ 08003
Attn. Field Service Dept.
(609) 235-2600, x8273

Central: 851 Feehanville Drive
Mt. Prospect, IL 60056
Attn.: Field Service Dept.
(708) 390-8610, x21

West: 1101 Cadillac Court
Milpitas, CA 95035
Attn.: Field Service Dept.
(408) 945-6600, 

x3322/3335

Canada: 2735 Matheson Blvd. East
Unit 1
Mississauga, Ontario 

L4W4M8
(905) 602-6400, x235

Overnight Exchange
If you choose to use our Overnight Exchange service, call 1-800-OKIDATA: if our trained 
personnel determine that your printer hardware is defective, an exchange machine will be 
shipped to you via air express, to be received the next business day or no later than the 
second business day.
You must return the failing machine to OKIDATA by packing it in the materials from the 
exchange machine and making it available for pickup by OKIDATAs representative within 
two business days from your receipt of the machine: failure to do so will result in your being
charged the full price of the exchange machine.
For more information, see your OKIJET 2010 Users Guide.

 This information is valid for the United States and Canada only. 



Ordering Print Cartridges

How to Order Print Cartridges
Before you order, make sure you know your printer model number (on the front of the unit) 
and have the correct description and part number for the print cartridge.

Description Part No.
Black Print Cartridge 52109301
Color Print Cartridge 52109302

Ways to Purchase Print Cartridges

In the United States:
Consult the dealer where you purchased your printer
Consult an Okidata Authorized Sales or Service Dealer. Call 1-800-OKIDATA for the 

nearest Authorized Sales and Service location. Have your ZIP code and telephone area code 
ready for our Customer Support Representatives.

To purchase print cartridges directly from OKIDATA, call 1-800-OKIDATA.
In Canada:

Consult the dealer where you purchased your printer
Consult an Okidata Authorized Sales or Service Dealer. Call 1-800-OKIDATA for the 

nearest Authorized Sales and Service location. Have your ZIP code and telephone area code 
ready for our Customer Support Representatives.

To purchase print cartridges directly from OKIDATA, call 1-905-602-6400.
In South America:

Consult the dealer where you purchased your printer

See also
Your printer User's Guide
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Introduction
Welcome to the printer driver for Microsoft Windows.    It is designed to make your printing 
fast and effortless, giving you fast release from your application programs as well as 
exceptional print quality.



Printer Driver Overview
This printer driver gives you a number of significant printing advantages.

It is easy to select the printing options because most selections will show you on-
screen graphics of how they will appear when printed.    Tabbed folders also give you quick 
access to all printing options.

Your software release time is very quick even when using sophisticated print options 
such as Air Brush.

Colors are richer and more true to the screen image because the printer driver uses 
color correction for screen-to-printer color WYSIWYG.

Photographs look realistic and graphics appear smoother because of the printer 
driver's advanced Air Brush (diffusion) halftoning.

Overall, the printer driver reduces print time significantly, especially for color print 
jobs.
The printer driver consists of a number of distinct elements:

The printer driver for your printer.
The Spool Manager.
The Printer Control Program.

Each of these elements works together to provide an optimum printing environment for 
your printer.
The printer driver is generally accessed from the Printer Setup option in your application 
software or from the Printers icon of the Microsoft Windows Control Panel.
The printer driver can also be accessed by choosing the Windows Printing tab in the Printer 
Control program.
See Also
A Technical Description of the Printer



Release Time
This is the time that it takes for control to return to you from the Print option within your 
application.
The printer driver returns you to your application quickly so that you can continue working 
while your printing completes in background.



WYSIWYG
What You See Is What You Get. Generally with the printer driver, what you see on the 
screen is what you get on the printer in terms of colors, image size, and density.



Diffusion
Most printing systems use dithering to represent an image, which can give a grainy result. 
The printer driver supports Air Brush (diffusion) printing and uses an advanced rendering 
technique to generate a smoother image.    Graduated fills look better, images look clearer 
and photographs look much closer to the original.
With very complex images, Air Brush printing can sometimes take a little longer than 
dithering, but generally the results are well worth it.    You will have to experiment with the 
halftone that best suits the picture that you are printing.



Air Brush
Air Brush is a name for a modified Floyd-Steinberg Error-Diffusion, sometimes called the 
diffusion or scatter style of printing.



Dithering
When images are printed using the dithering selections from the halftoning tab, the printer 
driver uses a matrix of dots to represent the image. You will have to experiment with the 
halftone that best suits the picture that you are printing. In most cases the Air Brush setting
should give the best results.



A Technical Description of the Printer
If you are familiar with the internal operations of Microsoft Windows, the following technical
description may be of interest.
This printer is an advanced Windows GDI-style software printing system that operates as 
follows:

The application is told by the printer driver that the printer is a raster device that can
render the entire image in a single band. The printer driver also reports that certain 
advanced printing options are supported.    All of these special capabilities saves the 
application work and avoids having to replay the picture multiple times.

The Graphics Device Interface (GDI) commands necessary to represent the image are
encoded into a highly-optimized journal file. The application releases when generation of the
journal is complete. Journal files are very compact and are the same size regardless of 
whether the print is in color or monochrome.    Using a journal means that the entire 
document can be replayed to simulate multiple hardware copies or to provide last-to-first 
printing options.

The Spool Manager initiates the Printer Control Program, which replays the journal file
back to the mini-driver for the target device.    Both the Spool Manager and the Printer 
Control Program use a highly efficient tasking system to ensure minimum impact on the 
foreground application.
See Also
Spool Manager
Printer Control Program Overview
Journal File



Windows GDI
Graphics Device Interface (GDI) is the part of the Microsoft Windows environment that 
allows applications to draw lines, circles, polygons, text and control other graphic elements 
on the output device (screen, printer, plotter, and so on).



Printer Setup
The printer driver is designed to provide the best print output default settings for your 
printer. If you need to change the default settings, the printer driver provides you with 
easy-to-use tabs containing printer setup options.    The setup options for the printer driver 
can be reached through the Windows Control Panel, through the Print Setup option of most 
software, and through the Printer Control Program.
See Also
OK Button, Cancel Button, Defaults Button



Paper
Paper Size
User-Defined Paper Size
Orientation
Paper Source
Copies
Collate
Reverse Page Order



Media Type & Print Quality
Media Type
Print Quality
Addressability
High Speed Printing Option



Document Type & Color Format
Document Type
Color Format



Paper Size
Click the paper size that you want from the Paper Size list.    If the paper size required is not
displayed, use the scroll bar to locate the correct size.    You can also click one of the sizes 
displayed and then use the arrow keys on your keyboard to move up and down the list.    
The graphic below the list displays the currently selected paper size, orientation and 
printable area (shown by the dimensions within the dotted lines).



User-Defined Paper Size
When you select the User-Defined option from the Paper Size list, a popup window appears.
Enter the width and height of the paper. The dimensions you enter should be the full size of
the paper.    The actual printable area will normally be slightly less than these dimensions.



Orientation
Portrait and landscape orientations define the way that the image is printed on paper.    For 
most paper types, portrait is tall:
Portrait

and landscape is wide:
Landscape

Portrait orientation is generally used for correspondence and reports.    Landscape 
orientation is often used for spreadsheets, transparencies, and envelopes.



Paper Source
Use the drop-down list to select a paper source for your printer. The printer has an 
Automatic Sheet Feed and a Manual Sheet Feed. See your printer User's Guide for more 
information.



Copies
Enter the number of copies from 1 to 99 that you want printed. If your application lets you 
specify the number of copies, it is generally best to set this number to 1 and specify the 
number of copies in your application.



Collate
Use this option when you are printing multiple copies so that all pages of one copy are 
printed before the next copy begins printing.



Reverse Page Order
Choose Reverse Page Order to begin printing with the last page of the document, so that 
the first page of your document will be on top of the stack in the output tray when your 
print job is complete.



Color Format
Choose Monochrome if you want to print with only the black cartridge (the color cartridge is
not used).
Choose Color (CMY) if you want to print with only the color print cartridge.
Choose Color/Monochrome (CMYK) if you want to print with the color print cartridge and 
with the black print cartridge.



Addressability
The Media/Quality tab of the printer driver lets you select the number of dots per inch (dpi).
Choosing the highest dpi produces finer, high-quality print, but takes longer to process and 
print. Use the lower dpi for normal, everyday printing.
Note: The Print Preview function available in some applications may not be able to display 
an image correctly when 600 x 300 dpi is selected. However, the image will print correctly.



Print Preview
The ability to see how the printed page will appear before it is printed.



High Speed Printing
Choose High Speed Printing to speed up the printer.
If you are experiencing blurred or fuzzy printing, turn off the High Speed Printing option.



Halftoning
The Halftoning tab lets you select the fine dot pattern used to create printed images. In 
general, pattern dithering produces textured images and is suitable for general word 
processing and simple, solid graphics.
The No Halftoning option can be selected if you only want to print plain (non-dithered) text.
Use the Air Brush option if you want to enhance photographs and produce smoother-
looking quality pictures. Text output quality is excellent for all halftoning methods.
Make sure you choose the halftoning option that is appropriate to the type of picture you 
are printing. Use the following table as a guide.

Halftone method Use for...
No halftoning text and no graphics. This is the 

fastest setting.
Line art pattern simple line art and computer 

graphics.
Fine dither pattern graphic images with significant 

detail but limited shading.
Air Brush 
(Standard)

photographic images or 
equivalent drawing. Excellent 
quality, normal speed.

Note: 
You should experiment with different Halftone options to learn which ones are best suited to
your printing needs.



Media Type
Choose the media type you want from the Media Type list. The Print Quality selection 
changes automatically based on your Media Type selection to give you a higher level of 
print quality on special media.

Select Plain Paper for typical xerographic paper.
Select Coated for printing on coated papers specifically designed for printing with the

color cartridge.
Select Premium Coated Paper for printing on coated papers specifically designed to 

print with the color and black cartridges.
Select Transparency for printing on a transparency.
Select Glossy for printing on glossy paper.

For more information on the types of paper that work best with this printer, see Paper Types
and Sizes.



Print Quality
This option lets you control the print quality of your output. The option you select may 
affect the speed of your output as well.

Select Presentation for best print quality and reduced speed. 
Select High for slightly reduced speed and good print quality. Slowing down the print 

speed can improve print quality on some papers.
Select Normal for normal speed and good print quality. 
Select Draft quality for fast speed, ink conservation, and good print quality.



Image Settings
The Image Settings tab lets you override the default image settings used by the printer 
driver. Although the settings are designed to give you the best results, this tab gives you 
additional custom control.
You can control the brightness and contrast settings. The image to the right of these 
controls gives an impression of the final result of your changes to the settings. The image 
may not appear exactly as you would expect if your color monitor does not support enough
colors. 
Changing the Image Bitmap
If you want to load another bitmap (.BMP) file in place of the default, double-click inside the
image area. A Change Image Control Bitmap file dialog box will display to let you choose 
another bitmap file. Depending on the size of the bitmap you choose, only a portion of the 
bitmap may be displayed.
Enable Ink Density Correction
This option adjusts the amount of ink the printer uses during printing to compensate for the
density of the ink.    Printing without this option usually produces pictures that are darker 
than shown on screen.    This option is checked by default.



OK Button
The OK button closes the dialog and saves any changes that may have been made. Click 
the OK button if you open a dialog box and make changes you want to save.
Selecting the OK button:

Click the mouse over the button.
Press the Enter key at any time the input focus is not on one of the other three 

buttons.
Press and release the space bar while the button has input focus.



Cancel Button
The cancel button closes a dialog and discards any changes that may have been made. 
Click the cancel button if you open a dialog box and make changes that you decide you do 
not want.
Selecting the Cancel button:

Click the mouse over the button.
Press the Esc key at any time.
Press the Enter key while the button has input focus.
Press and release the space bar while the button has input focus.



Defaults Button
The Defaults button restores all of the driver settings to those you had when the printer 
driver was first installed on your system.



Document Type
The Document Type option is used to quickly configure the driver for a particular type of 
document. When a document type is selected, other options within the driver setup change
to best accommodate that document type.
After selecting a Document Type, you might want to browse through the Media/Quality, 
Halftoning, and Image Settings tabs to see the settings. You are free to change any of the 
options that are affected by the document type but, if you do, the current document type 
will change to the Custom setting.

Document 
Type

Settings

Automatic Selects the appropriate settings 
for Print Quality, Color Format, 
and Halftoning, depending on the
document type.

Black Text Sets addressability to 300 x 300, 
Print Quality to Normal, Color 
Format to Monochrome, and 
Halftoning to Airbrush 
(Standard).

Photographic 
Color

Sets addressability to 300 x 300, 
Print Quality to High, Color 
Format to Color/Monochrome 
(CMYK), and Halftoning to 
Airbrush (Standard).

Business 
Graphics

Sets addressability to 300 x 300, 
Print Quality to Normal, Color 
Format to Color/Monochrome 
(CMYK), and Halftoning to 
Airbrush (Standard).

Gray Scale Sets addressability to 300 x 300, 
Print Quality to High, Color 
Format to Monochrome, and 
Halftoning to Airbrush 
(Standard).

Color Draft Sets addressability to 300 x 300, 
Print Quality to Draft, Color 
Format to Color/Monochrome 
(CMYK), and Halftoning to Line 
Art.

Black Draft Sets addressability to 300 x 300, 
Print Quality to Draft, Color 
Format to Monochrome, and 
Halftoning to Line Art.

Custom Automatically selected if you 
change any of the options 
affected by the chosen document
type.



About
The About box tells you the version numbers of your printer driver, and trademark and 
copyright information.



 Cartridges
Install Cartridges
Clean Print Nozzles
Align Cartridges
Ink Saver



Install Cartridges
Choose Install Black Cartridge to initiate print cartridge installation and reinstallation for the
black print cartridge. See your printer User's Guide for more information.
Choose Install Color Cartridge to initiate print cartridge installation and reinstallation for the
color print cartridge. See your printer User's Guide for more information.



Clean Print Nozzles
Choose Clean Print Nozzles to initiate the print cartridge nozzle test and cleaning. Use the 
cleaning procedure when you think one or more of the nozzles on the printhead are 
clogged. (Missing portions of characters indicate clogged nozzles.) For more information, 
see your printer User' s Guide.



Align Cartridges
Select the alignment patterns for Horizontal Align, Vertical Align, Black Bidi Align, and Color 
Bidi Align, and enter the values in the appropriate boxes.
When choosing the Black and Color Bidi Align patterns, look closely and choose carefully. If 
the pattern you select is not a good alignment, select the best alignment pattern and 
perform the alignment procedure again. You might have to do the alignment procedure 
several times to get good bidirectional alignment for the black and color printheads.
See aligning the printheads section in your printer User's Guide for more information.



Ink Saver
Ink Saver settings let you to vary the amount of ink the printer uses to produce text and 
graphics. Using the ink-saver feature can increase cartridge yield, improve print quality on 
some papers, reduce darkness of print, and reduce time required for ink to dry.

From the Ink Saver list, choose Off, Medium, or Maximum.
Off turns off ink saving.
Medium indicates Ink Saver is active at a medium setting.
Maximum indicates Ink Saver is active for the maximum ink savings. Maximum keeps

the ink from soaking the page and reduces the amount of time required for the ink to dry. 
Use Maximum when printing graphics with large areas of solid or dark colors.



Status
The Status tab lets you view the amount of ink remaining in your cartridges, watch as your 
job progresses through the printer, and control some printer functions.
Button 
Name

Function

Cancel Print Stops the current print 
job and lets you choose
to delete the print job.

Resume/
Pause

Lets you Pause the 
current print job. If a 
job is paused, the 
button becomes a 
Resume button to let 
you resume a paused 
print job.

Reprint Lets you reprint a print 
job starting with a 
specific page. Useful for
recovering a page lost 
due to a paper jam or 
paper misfeed.

Eject Paper Performs a form feed.
Print Test 
Page

Lets you print a test 
page to ensure your 
printer is functioning.



Options
The Options dialog box lets you select how status information is displayed and lets you 
enable sound effects.
Status Monitor Options

Always on Top displays this printer's status boxes always on top of other windows.
Popup on Error displays the Printer Control Program dialog box when you are printing 

and an error occurs. This dialog box displays print job progress and printer status messages. 
Run Minimized reduces the Printer Control Program dialog box to an icon when you 

are printing.
Close Status at End of Job closes the dialog box when the job is complete.
Sound Effects Enabled turns on the sound files that were on your system when it was 

installed.



Cartridges
The Cartridges tab lets you perform cartridge maintenance functions and view the amount 
of ink remaining in your cartridges.
To initiate any of the maintenance functions, choose the appropriate button. For more 
information see:
Install Cartridges
Clean Print Nozzles
Align Cartridges



Change Color Cartridge
For the Ink Level Indicator to work correctly, you must make the appropriate choice in this 
window. 
If you are installing a new, unused cartridge, choose the New Cartridge Installed button. 
If you are reinstalling a used cartridge, choose the Old Cartridge Installed button.



Change Black Cartridge
For the Ink Level Indicator to work correctly, you must make the appropriate choice here. 
If you are installing a new, unused cartridge, choose the New Cartridge Installed button. 
If you are reinstalling a used cartridge, choose the Old Cartridge Installed button.



Align Cartridges
To obtain the highest quality from your printer, the cartridges must be aligned.    
The Align Cartridges dialog box is displayed automatically after a new cartridge is installed.
Printhead alignment can also be initiated by choosing the Align Cartridges button on the 
Cartridges tab. 
For complete instructions, see your printer User's Guide.



DOS Printing
The DOS Printing dialog box lets you change the printer setting for applications that are not
Windows-based applications.
Print Quality

Letter gives good print quality at normal speed.
Draft gives good print quality, fast speed, and ink conservation.

Ink Saver
Ink Saver settings let you vary the amount of ink the printer uses to produce text and 
graphics. Using Ink Saver can increase cartridge yield, improve print quality on some 
papers, reduce darkness of print, and reduce the time required for the ink to dry.

Off turns off Ink Saver.
Medium indicates Ink Saver is active at a medium setting.
High indicates Ink Saver is active for maximum ink savings, especially when you print

graphics with large areas of solid black or dark gray. This setting keeps the ink from soaking 
the page, and reduces the amount of time required for the ink to dry.
Paper Source
The printer has a Manual Sheet Feed and a Automatic Sheet Feed.

Select a paper source from the list.
Paper Size

Select the paper size you want from the list.
Paper Type

Select Plain Paper to print on normal xerographic paper.
Select Coated Paper to print on coated paper for ink-jet printers.
Select Glossy Paper to print on glossy paper.
Select Transparencies to print on transparencies.

Orientation
Select Portrait to print in an upright page orientation (the page is taller than it is 

wide).
Select Landscape to print in a horizontal page orientation (the page is wider than it is 

tall).    When Landscape is selected, you can select from three fonts: Courier 10, Courier 
16.67, and Courier 20.
Font Settings

Select a Font from the list.
Select a Character Set from the list.

Enable Font Download
Select Enable Font Download to use any fonts that were downloaded from a software 

application.
Other

Select the Graphics resolution in dots per inch (dpi) from this list.    The default is 75 
dpi.

Select a CR (carriage return) from this list. CR and LF instructs the printer to perform 
a line feed (LF) after each carriage return (CR). The default is CR Only.

Click Text Scale Mode to turn on text scaling. Text Scale Mode affects the vertical line 
spacing of your print job. For example, for a 216 x 279 mm (8.5 x 11 in.) page with a 13mm 
(1/2 inch) bottom margin, Off prints 63 lines per page; On prints 66 lines per page.    Note: 



When Perforation Skip is On, Text Scale Mode is ignored.
Click Perforation Skip to turn it on. When it is on, the printer adds a 13mm (1/2 in.) 

top margin to the print job.    Note: When Perforation Skip is on, Text Scale Mode is ignored.
Select Redirect Port to change the printer port. This option allows you to perform PCL 

3 emulation printing from the DOS box of Windows.
Select High Speed Printing to print at a faster rate.
Select Form Feed Timeout to designate the timeout period for form feed. The default 

is 15 seconds.
Click Print Fonts to print out a list of available fonts.
Click Defaults to return all options settings to those you had when the printer driver 

was first installed on your system.



Windows Printing
Click Windows Driver Setup to access the Media/Quality, Paper, Cartridges, Document 
Type/Color, Halftoning, and Image Settings tabs. These tabs let you select options that 
control how your output appears when it is printed.
Click Spool Manager to access the Spool Manager window.



The Spool Manager
When the printer driver releases your program, a print file is created in the default spool 
directory.    When a print job is created, the Spool Manager is notified and assigns it to the 
print queue. When the print job comes to the top of the queue it is submitted to the Printer 
Control Program and sent to the target printer.
The Spool Manager allows comprehensive control over the Printer Control Program, print 
queues, and print jobs. You can also enable remote network printing from the Spool 
Manager.
The Spool Manager Window
The Queue Menu
The Document Menu
The View Menu
The Options Menu
The Help Menu



Journal File
The printer driver generates a compact print job file, which contains a complete description
of your print job in a form that can be processed easily.    This file is similar to a tape 
recording in that it can be played (printed), replayed (reprinted) and rewound (restarted) in 
order to process your print job.



Default Spool Directory
The Default Spool Directory for print job files is usually specified by the DOS environment 
string SET TEMP=.
To change this setting, select the Default Spool Directory item from the Options menu in 
the Spool Manager.



The Spool Manager Window
The Spool Manager window shows the list of print jobs currently printing or waiting to print.
Queues
The print queue is shown in normal intensity.    Queues shown in low intensity are supported
by other Windows printer drivers.
You can change the print queue setup by double-clicking on it or by clicking once to select 
it and then choosing an option from the Queue menu.
Print Jobs
Print Jobs sent to the printer are shown in the print queue for this printer.
You can stop individual print jobs from printing, place a job on hold, delete a job, or queue a
job for later printing either by double-clicking the print job or by clicking once to select it 
and then choosing an option from the Document menu.



Queues
A queue is a list of print jobs currently printing or waiting to print. Queues are always 
associated with a print device and can be local to the workstation or remote (directed 
across a network to another workstation).
When you hold a queue, print jobs will not be printed but will wait until the queue is 
released.    You will see a wait symbol by the printer icon when the queue is on hold.



The Queue Menu
The Queue menu lets you put print queues on hold, release the queues so jobs will print, 
and identify queues as local or remote (for network printing). The following options are 
available:
Holding a Queue
1. Click the printer queue for this printer.
2. Select Hold from the Queue menu.
A check mark is placed next to Hold to indicate the queue is currently on hold. The Spool 
Manager also places a wait symbol beside the printer icon.    Print jobs are not submitted for
printing.
Releasing a Queue
1. Click the printer queue for this printer.
2. Select Hold from the Queue menu to remove the checkmark and release the queue.
Using The Windows Print Manager
The Printer Control Program usually prints directly to the printer. If you are using a network 
or if you wish to schedule print jobs through the conventional Windows Print Manager, 
follow these steps:
1. Click the printer queue.
2. Either double-click the queue or select Setup from the Queue menu.
3. Select Use Print Manager for This Port and click OK.
Network Printing
This printer allows you to send print job files from your workstation (Host) to a shared 
directory on a network server. These files can be printed by another workstation (Remote) 
that is set up to run the Spool Manager and associated printer driver(s). You can do this as 
follows:
Host Setup
1. Click the printer queue for this printer.
2. Either double-click the queue or select Setup from the Queue menu.
3. Select the printer option Spool to Remote.
4. Click the Browse button and select the spool directory on the remote server that you 

want to receive print files from the Spool Manager.
Remote Setup
1. Install the printer driver and the required printer driver(s) using the Installation Diskettes 

provided with your printer.
2. Run the Spool Manager by executing WWSPLMGR.EXE from the WINDOWS\SYSTEM 

directory.
3. Either double-click the queue or select Setup from the Queue menu.
4. Select the Remote Despool tab and click Printing from Remote Queues.
5. Click the Browse button and select the spool directory on the remote server that will hold

print jobs from host workstations.
Journals will be identified by the Spool Manager and submitted for printing.

Note:
This feature is quite different from the traditional remote printer spooling provided by most 
network operating systems. Use your network to redirect the printer LPTx: ports in the 
usual way to take advantage of that feature. You may also need to enable the Windows 
Print Manager as described on some network operating systems when port redirection is 
utilized.





The Document Menu
The Document menu allows you to control individual print jobs in your queue. 
To select options appropriate to a print job, either double-click the print job or select Info 
from the Document menu.
Print jobs can be held, requeued for printing later, deleted, or kept for subsequent 
reprinting.



The View Menu
The View Menu lets you limit the amount of information that the Spool Manager gives you. 
In addition, you can control the display of the Printer Control Program window. Spool 
Manager places a check mark beside each option selected in the View Menu.
If the Show Despool Popup is cleared (no check mark is beside it), the Printer Control 
Program window does not appear when print jobs are submitted for printing. The Printer 
Control Program popup does appear, however, if an error is reported by the printer.
For more information about the Printer Control Program, see Printer Control Program topic.



The Options Menu
The Options Menu controls the default spool directory, timer and font selections as follows.
Default Spool Directory
To override the default TEMP directory setting, choose a default spool directory from the 
Options menu. Print jobs will be sent to this directory instead. This option is equivalent to 
the Spool Directory setting in the Queue Menu Setup option, except that it applies to all 
queues.
Timers
The Update Timer tells the Spool Manager how often to refresh the information displayed in
the    Spool Manager window.
The Remote Timer tells a remote Spool Manager how often to look for new print jobs in a 
network directory.
See the Queue Menu for more details about network printing.
Font
This option lets you set the default font that the Spool Manager uses for displaying 
information in the Spool Manager window.



The Help Menu
The Help Menu provides copyright, trademark and version information about the Spool 
Manager through the About option.



Printer Control Program Overview
When a print job is processed by the Spool Manager, it is submitted to the Printer Control 
Program. 
The Printer Control Program lets you view printer status, print from DOS applications, 
perform cartridge maintenance functions, view print job progress, and control how your 
printer handles status windows. You can also use the Printer Control Program to cancel a 
print job, pause or resume a print job, and print a test page.
Status messages and symbols representing error conditions are displayed on the image of 
your printer in the Printer Control Program window.
When you correct a problem with the printer, the Printer Control Program senses this and 
continues with the print job.    If a serious error occurs, such as printer power failure, it is 
suggested that you requeue the print job and print it again.
Unless indicated otherwise in the Options tab, the Printer Control Program window appears 
automatically when you submit a job for printing.
To access the Printer Control program when you are not printing:
1. Open the program group for this printer.
2. Double-click on the Printer Control program icon.



Questions and Answers
The following common questions and answers provide important information about using a 
printer driver:

Q.Do I really need to change ink or Halftone options in the printer driver setup?
A. Not really. You can use the default printer driver settings for most printing needs. 

However, if you want a different resolution or special paper for presentations, you must 
change some settings.

Q.What does the Defaults button do?
A. It restores the driver settings to those you had when printer driver was first installed on 

your system.
Q.Although I selected one of the Air Brush halftone options, my pictures do not appear to be

diffused. Why?
A. Your software may be overriding the halftone processing of the driver. Look at your 

software for an option that lets you use printer halftones so that the printer driver can do 
its job.

Q. I am trying to print an image. Whatever Halftone option I select in the printer driver, the 
resulting output always looks the same. What is the problem?

A. It may be that the image you are trying to print has already been set to halftone by your 
software and the software is overriding the halftone setting of the driver. Look at your 
software for an option that lets you use printer halftones so that the printer driver can do 
its job. You can also print the image with another program.

Q. I am printing a word processing document and my print time is quite slow. What is the 
reason for this?

A. The Air Brush (Standard) option in the halftone settings dialog box is the default setting 
on most printer drivers. Although this setting usually gives the best print quality for 
graphics, the dither options provide greatly enhanced print performance when you print 
text-intensive documents. Also, change the Print Quality setting to Normal or Draft. 

Q. I cannot seem to print to a Windows remote printer from my Windows for WorkGroups or 
LAN setup. What is the problem?

A. You need to direct the Spool Manager to print through the standard Windows Print 
Manager. Do this by running WWSPLMGR.EXE. Double-click the printer queue that you 
wish to direct through Print Manager. Select the Use Print Manager for this port option. 
Choose the OK button and close the application. Subsequent prints will be sent through 
the Windows Print Manager by the Printer Control Program.

Q. I am using a NEC PC-98 series computer and cannot print to LPT from the printer driver.
A. You may need to direct Spool Manager to print through the standard Windows Print 

Manager. The procedure for doing this is described in the answer to the previous question.
Q. I would like to send my print jobs to a remote Spool Manager across a network.    Can I do 

this?
A. Yes.    Use the Search menu of the Help window to learn about the Spool Manager Queue 

Menu.
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